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Disclaimer: This manual is intended to be used in Introduction to Marxan courses provided by 

PacMARA and not as a stand-alone document.  In addition, this manual only covers some of the 

basic functionalities of Marxan.  Please consult the Marxan Manual 

(http://www.uq.edu.au/marxan) and Marxan Good Practices Handbook  

(http://pacmara.org/tikiwiki/tiki-index.php?page=Marxan+Resources+and+Training) for 

technical information and additional functionalities on Marxan.  
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Exercise 1: Reserve Design Activity (without Marxan) 

Natural resource managers have a limited budget to use for protecting and maintaining 

biodiversity. As a result, it is important that this money is used efficiently.  In this activity, you 

will act as the natural resource manager, trying to create a comprehensive, adequate, 

representative, and efficient reserve system. Your region consists of 100 square planning units 

that are 100 hectares in size, and they contain 3 biogeoclimatic zones that you are trying to 

represent in your reserve system. There are several things to consider when creating your reserve 

system:  

 

1. Meeting conservation targets; 

2. Achieving a spatially “clumped” solution for ease of management and to minimize 

fragmentation; and 

3. Minimising the cost of your reserve system. 

 

In this activity, you will design a reserve network (by hand) that reaches your conservation 

targets in a cost effective manner while considering the spatial compactness of your solution. 

This activity uses the same kind of information that Marxan requires to find potential reserve 

networks, and the aim is for you to consider the methods and challenges of finding efficient 

solutions.  At the end of this exercise we will see the solutions that Marxan provides to the same 

problem.  

 

You will use the “maps” (Figures 1 and 2) on the next page to help you with this exercise. Figure 

1 shows the planning unit id numbers and the cost of including that planning unit in the reserve 

system, and Figure 2 shows how much of each of the biogeoclimatic zones are contained in each 

planning unit. 

 

Your objective is to represent 20% of the total biogeoclimatic zone area for the biogeoclimatic 

types 1, 2, and 3, in the study region (see Table 1) at least cost (refer to spreadsheet and Figures 

1 and 2). 

 

Table 1.  Biogeoclimatic zone description, type number, area occupied, and target area 

Biogeoclimatic zone description Biogeoclimatic zone  type Total area Target area 

Coastal Western Hemlock 1 1337 267.4 

Coastal Douglas-fir 2 1256 251.2 

Mountain Hemlock 3 1215 243 

 

 Navigate to the folder “C:\IntroMarxan\Reserve_design_exercise” and open the Excel file 

titled “Reserve_design_activity.xls” 

 

This spreadsheet has information for each planning unit (total of 100 planning units), each with 

an assigned Planning Unit Identification Number or PUID, the cost of the planning unit (COST) 

and how much of each of the three biogeoclimatic zone types is contained in that planning unit 

(BZ_1, BZ_2, BZ_3).  

 

You can select a planning unit to include it in your reserve system by changing the value in the 

“SELECTED” field from 0 to 1.  To see the spatial information about the cost of each planning 
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unit, and the habitat occupied by each species in each planning unit, see Figures 1 and 2 (next 

page). When you select a planning unit to be included in your reserve system, the summary 

information table is updated to provide you feedback on the selections; that is, the SUM COST 

(the summed cost of the reserve system selected), and the TARGET GAP (the amount needed to 

meet the targets for the reserve system) are updated: 

 

Summary information 

SUM COST (total cost of all planning units selected) 0 

TARGET GAP (summed amount in area required to meet remaining targets) 761.6 

 

You can also track the individual species targets as you change the planning units selected: 

 

Biogeoclimatic zone (BZ) type BZ# total area target amt held target gap target met 

Coastal Western Hemlock 1 1337 267.4 0 267.4 NO 

Coastal Douglas-fir 2 1256 251.2 0 251.2 NO 

Mountain Hemlock 3 1215 243 0 243 NO 

 

 Use the spreadsheet and Figures 1 and 2 to find a reserve system that meets all of your 

conservation targets in a cost effective (and clumped) way 

 When you find your solution, calculate the boundary length (the number of free edges * 

100) and the sum cost, and then record here _____________________ 

 

After you have completed the exercise, as a class we will compare how well our solutions 

perform compared to a Marxan generated solution.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 6 

Data used in exercise 

 

1_347 2_52 3_985 4_207 5_276 6_821 7_122 8_404 9_300 10_681 

11_813 12_537 13_931 14_653 15_919 16_826 17_455 18_983 19_731 20_875 

21_247 22_462 23_287 24_988 25_85 26_736 27_681 28_479 29_459 30_615 

31_378 32_986 33_887 34_392 35_526 36_783 37_224 38_149 39_268 40_90 

41_977 42_74 43_53 44_390 45_619 46_773 47_952 48_738 49_897 50_580 

51_969 52_76 53_147 54_870 55_350 56_543 57_607 58_375 59_903 60_790 

61_729 62_492 63_303 64_289 65_490 66_599 67_407 68_651 69_709 70_365 

71_571 72_931 73_353 74_64 75_955 76_950 77_855 78_886 79_840 80_840 

81_422 82_252 83_941 84_152 85_353 86_123 87_716 88_587 89_346 90_318 

91_682 92_891 93_815 94_818 95_726 96_372 97_197 98_89 99_417 100_975 

Figure 1: Planning unit identifiers and cost (PUID_COST). 

 

    0_0_1   89_0_12 30_48_0 69_4_9     0_0_91 

        71_43_12 99_0_1   17_0_0 0_0_35 31_0_0 

  55_40_0   0_2_27 70_0_0 37_0_56   0_0_3 0_41_0 54_0_0 

  80_8_0 0_47_0   0_78_0 0_0_87 66_0_38     0_91_0 

  0_0_73 0_60_0 25_79_0   11_0_8       0_0_53 

76_34_0 0_90_0 0_84_0 0_0_82 0_72_26   0_0_21 58_0_0   0_54_59 

75_0_60           91_0_0 0_0_57 0_42_97 0_0_7 

  0_37_0           0_23_0 0_41_0 81_0_37 

0_0_12     0_53_24 0_72_0 93_0_0   0_23_59     

  11_0_0 0_14_50   0_0_88     48_0_0   0_76_0 

Figure 2: Area occupied by each biogeoclimatic zone in each square: BZ1_BZ2_BZ3 
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Exercise 2: Case Study Profile  

Marine case study region: The Pacific Ocean between Hakai Pass and Port Hardy to the edge 

of the continental shelf, British Columbia, Canada. 

 

Objective: Identify cost-effective areas for inclusion in a marine protected area network that 

protect a specified portion of each conservation feature. 

 

Decision support tools: Marxan and Zonae Cogito. 

 

GIS tools: There are many ways to create and view Marxan files. In this course, we present one 

method using ArcGIS, and another using the open course GIS software Quantum GIS (QGIS) 

with the QMarxan plug-in. 

 

Disclaimer:  This project is for training purposes only and is not intended to represent a full 

analysis of the conservation features and costs that would be necessary to provide options for a 

marine protected area network in this region. Conservation feature data were generously 

provided for this purpose by the British Columbia Marine Conservation Analysis (BCMCA) a 

collaborative project designed to provide information about marine biodiversity and human 

activity in BC’s marine waters (www.bcmca.ca).   

 

The data layers are: 

1. Study_Region_BC_Ocean: Marine extent of study region 

2. Study_Region_BC_Land: Land extent of study region 

3. Vessel_cost: Vessel movement data (including fishing, carrier, ferry, tug, oil tankers, and 

cruise ships) that represents the cost to industry as a result of inclusion in marine protected 

area network. These cost values were extracted  based on the square root of the number of 

vessel counts in a cell and then reclassified in four classes (more information about the 

original data can be found here).  

 

The biodiversity features that we provide you with are: 

1. Benthic_BC: layer that details the extent of a selection of benthic classes (55 total classes; or 

16 classes in the QMarxan example) in British Columbia. The benthic classification is based 

on depth class, substrate, and slope. Each benthic class will be considered as one 

conservation feature (more information about the original data can be found here). 

2. Spngereefs_BC: distribution data for sponge (more information about the original data can 

be found here). 

3. Bull_kelp_BC: distribution data for bull kelp (more information about the original data can 

be found here). 

4. Giant_kelp_BC: distribution data for giant kelp (more information about the original data 

can be found here). 

5. Kelp_gen_BC: distribution data for general kelp (more information about the original data 

can be found here). 

file:///C:/Users/Norma%20Serra-Sogas/Dropbox/Marxan%20courses/Handbooks%20&%20ppts/Handbooks_new/IntroMarxab_Handbooks_with_QMarxan/IntroMarxan_Handbooks/www.bcmca.ca
http://bcmca.ca/?s=vessel+density
http://bcmca.ca/datafeatures/eco_physical_benthicclasses/
http://bcmca.ca/datafeatures/eco_inverts_spongereefs/
http://bcmca.ca/datafiles/individualfiles/bcmca_eco_kelp_bullkelp_polygons_atlas.pdf
http://bcmca.ca/datafeatures/eco_kelp_giantkelp_polygons/
http://bcmca.ca/datafeatures/eco_kelp_generalkelp/
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A. Creating Marxan input files in ArcMap  
This process involves the creation of four files necessary to run Marxan. These are: 

1. pu.dat - this is a text file that describes each planning unit, the cost of selecting that unit 

and the selection status of that unit. 

2. spec.dat - this is another text file that describes the “species” or conservation features 

that you want to include in your analysis. This file contains the “species” id, the 

conservation target (either proportion or absolute value), penalties for not meeting targets 

(SPF) and the descriptive names for each conservation features. 

3. puvsp.dat – this text file contains the amount of each “species” in each planning unit. 

4. bound.dat – this file describes the adjacency relationships between planning units and 

their shared boundary length. 

 

To start navigate to “C:\IntroMarxan\ArcMap_data” and double click on “IntroMarxan.mxd” to 

launch the ArcMap project. 

  

 Ensure the Spatial Analyst extension is enabled by clicking on “Customize”, “Extensions”, 

then enabling “Spatial Analyst” by checking its box 

 You may have to repair the data source if you see a red exclamation sign (!) next to each 

data layer. 

 Explore each data layer so that you have a better understanding of the type of information 

that you will be working with in this course 

 

Step 1: Creating Planning Units 

Planning units refer to the grid and cell size that you will use in your analysis.  

 

The size of the planning units is determined 

by the scale of the analysis, the resolution of 

the data used, and the objective of the 

planning exercise (see Marxan Good 

Practices Handbook for more information). 

Planning units can be squares, hexagons, or 

irregular shape polygons. With help of GIS 

you will calculate the area within each 

planning unit covered by each conservation 

feature distribution, and use these quantities 

to run a Marxan analysis. 

 

Next you will create a square grid for the 

British Columbia dataset with 2 x 2 km
2
 

cells (2000 x 2000 m
2
).  Note that the GIS 

data for the study region are in main units of meters. 

 

In this exercise you will learn how to create a planning unit layer using a free extension for 

ArcMap called ET Geowizards (http://www.ian-ko.com/). As an alternative, Jenness Repeating 

http://pacmara.org/wp-content/uploads/2010/07/Marxan-Good-Practices-Handbook-v2-2010.pdf
http://pacmara.org/wp-content/uploads/2010/07/Marxan-Good-Practices-Handbook-v2-2010.pdf
http://www.ian-ko.com/
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Shapes (www.jennessent.com/arcgis/arcgis_extensions.htm) can also be used to create planning 

units as described in the Appendix of this manual.  

 

Note: It is important to highlight that the different tools available to create grids or fishnets vary 

in the way they are produced and how they are indexed. For this reason it is important to 

explore the different tools and choose the one most suitable for the analysis at hand. 

Step 1a: Creating Planning Units using ET GeoWizards  

Note: there are many ways to create planning units – this is only one.  

 Click on the yellow “ET” button on the ArcMap toolbar    

 Click on the “basic” tab 

 Click on “Vector Grid” 

 Click “GO” 

 Select “Study_Region_BC_Ocean” from the first drop down list box 

 Click the browse button  

 Browse to “C:\IntroMarxan\ArcMap_data”  

 Type in “pulayer.shp” into the “Name” box, then click “Save”. Ensure your windows have 

the parameters shown here: 

  

 Click “Next” 

 Choose “Polygon” at the “Select GRID type”  

 Click “Next” 

 Here each unit in this British Columbia GIS dataset represents 1 m; thus (X=2000, Y=2000) 

means you are creating a grid of 2x2 km cells. 

http://www.jennessent.com/arcgis/arcgis_extensions.htm
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 Click “Finish” 

 

You now have a planning unit grid for the entire study region, including the part that is on land.   

Step 1b: Limiting the planning units to your study region.  

Because we are only considering those planning units that intersect with the ocean and not the 

land, we are going to perform a selection to only select the planning units that intersect with the 

layer Study_Region_BC_Ocean, and later export that selection to create a new shapefile of 

planning units.  

 In the main menu, choose “Selection,” then “Select 

by Location”  

 In the first drop down box, choose “select features 

from”  

 Tick the box next to “pulayer”  

 Choose the “Study_Region_BC_Ocean” in the 

second drop down box  

 Choose the "Target layer(s) features intersect 

source layer features" in the third drop down box. 

 Click “OK” 

 Note that in ArcGIS 9.x you should choose 

“intersect” in the second drop down box and 

“Study_Region_BC_Ocean” in the third drop down box 

 

You can see that the planning units that intersect the Study_Region_BC_Ocean layer are selected 

(now highlighted in blue). Now you will create a new shapefile only using these planning units.  

 

 Right click on “pulayer”  
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 Choose “Data”, then “Export Data” 

 Type “C:\IntroMarxan\ArcMap_data\pulayer_BC_Marine.shp” to name your new planning 

unit layer 

 Ensure that your axport window matches the parameters in the figure to the right. 

 Click “OK” 

 Click “yes” to add the exported data to the map as a layer 

 Choose “Selection” from the main menu, then “Clear Selected Features” 

 

If you cannot see your new layer, turn off the pulayer layer, and you should be able to view 

pulayer_BC_Marine.  

Step 1c: Creating planning unit unique ID field 

Marxan requires each planning unit to have a unique identifier or “planning unit id” or “puid”.  

In this step you will assign a unique ID to each planning unit. 

 Right click on “pulayer_BC_Marine” and open the attribute table (“Open Attribute Table”) 

 Click “Table Options” (top-left corner of the table) then “Add field” 

 Select “Long Integer” as the “Type” 

 Name the field “PUID” and click “OK” 

 Right click on the column title “PUID” and click “Field Calculator” 

 Under “Fields,” double-click on “FID” (so it appears in the calculation box), then on the “+” 

sign (on right hand side of window) then type in the number “1”, and then Click “OK”.  This 

assigns a unique ID to each planning unit, starting with 1 instead of 0. 

 Delete unnecessary fields by right clicking on the fields and select 

"Delete Field":  “Id”, “ET_ID”, and “ET_Index” 

 Close the table 

Now you have created your final planning unit shapefile. This will be 

used to create the files: pu.dat, puvsp.dat and bound.dat.  It will be also 

used by Zonae Cogito (Day 2) to visualize Marxan results.   

Step 2: Creating the planning unit file (pu.dat) 

Now you will be creating the pu.dat file that contains the planning unit 

id, cost (of that planning unit), and status (availability for selection).  

Step 2a: Creating cost table 

We have provided a GIS layer of vessel movement values to represent 

cost to industry if a planning unit is allocated to a marine protected 

area network.  Here, the value for cost is high if there are many vessels 

moving through that planning unit (e.g. class 4), and lower elsewhere 

(e.g. class 1).  You will calculate the expected cost of selecting each 

planning unit assuming that you are removing vessel access to a 

planning unit that is selected for reservation.  Think about this cost 
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layer. If you were doing this analysis, would you use 

this cost layer?  Why or why not? What cost data 

might be more useful?  Why do you think we did not 

use those data here? 

 

Note: Please ensure that the tables for your layers 

“pulayer_BC_Marine” and “Vessel_cost” do not 

have any rows selected or the “Zonal Statistics” 

function will not work correctly 

 Under “Spatial Analyst Tools” in the toolbox, 

“Zonal”, click on “Zonal Statistics as Table” 

If you can’t get to Spatial Analyst Tools, click on 

“Customize”, “Extensions”, then enabling “Spatial Analyst” by checking its box. 

 In ArcGIS 9.X, you will click on “Tools” instead of “Customize”  

 Type 

“C:\IntroMarxan\ArcMap_data\zonalst_cost.dbf” in 

the Output table box 

 Select "SUM" as the option for "Statistics Type" 

 In ArcGIS 9.x, you might have or not this 

option.  

 Ensure your “Zonal Statistics as Table” window has 

the parameters shown in the figure to the right. 

 Click “OK”  

This will create a table (ZonalSt_cost.dbf) that sums the 

vessel value (cost to industry) contained in each 

planning unit (indexed by PUID). 

Step 2b: Link data layers to create table for export 

Note: If you cannot see the table in ArcMap, you will 

need to select the “List By Source” tab in ArcMap 10. 

 Ensure that “Zonalst_cost.dbf” (cost of each 

planning unit) is added to ArcMap – to do this, 

click on the yellow sign “ ”, or right click the 

layer window and click “Add Data” 

 Now we will join the information in this table to the 

information in the planning unit file 

 First, right click on “pulayer_BC_Marine” and select “Joins and Relates” and then “Join”.  

In the first drop menu select the field “PUID”, in the second the table “ZonalSt_cost”, and  

in the third select the field “PUID” 

 Note that in ArcGIS 9.x, the field in the table to base the join on in the third table 

should be set to VALUE rather than PUID. 
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 Ensure your Join window has the following parameters shown in the figure in page 18. 

 Click “OK” 

 In ArcGIS 9.x click “Yes” on the “Create Index” box that appears 

 

Now the planning unit and cost data are joined, but you need to put this information into a format 

that Marxan can use. You will do this by exporting the data so you can open and edit it in Excel.  

Step 2c: Export data to create planning unit file 

You have now linked data on planning unit (PUID) and cost using the Join Data tool. This will 

let you export the cost and planning unit information into one file.  

 

 To export the joined data to a new table, right click 

on “pulayer_BC_Marine”, select “Data”, then 

“Export Data” 

 Type 

“C:\IntroMarxan\ArcMap_data\Export_puJoinCost.

shp” in the “Output feature class:” box to rename 

the shapefile 

 Ensure your Export window matches the figure to 

the right. 

 Click “OK” 

 Click “No” when asked to add exported data to 

map as a layer, this is so we can open it in Excel 

 Launch Excel. Open “Export_puJoinCost.dbf” in 

Excel (make sure that you have selected “show all file types” so that the .dbf files are visible) 

 Delete all columns EXCEPT: “PUID,” and “SUM”, which refer to your planning unit index 

and the cost of each planning unit 

 Rename “PUID” to “id” (must be in lower case letters), as this is what it must be called for 

Marxan to run 

 Rename “SUM” to “cost” (must be in lower case letters), as this is what it must be called for 

Marxan to run (sum is the area weighted cost of each planning unit) 

 Select the “cost” column, and reformat the cells to remove extra decimal places (right click, 

“Format Cells…”, “Category: Number”, “Decimal places: 0”) 

 

Now you have finished editing the first part of the pu.dat file, the information that indicates how 

much it costs for each planning unit to be included in a Marxan solution. Next you will add 

information about the status –whether or not a planning unit is available for selection.  

Step 2d: Setting the planning units status 

In Marxan, currently protected areas can be locked into the solution set to reflect that they are 

unlikely to be changed or moved.  To do this, the planning unit status must be assigned a “2” in 
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the planning unit file (a status of “0” is available; “3” is locked out; “2” is locked in). You will 

have the opportunity to lock planning units in or out of solutions in Day 2. You will now assign 

the status to all planning units by giving them a status of “0”, that is you will leave them all 

available for selection.  

 

Still working on Export_puJoinCost.dbf in Excel: 

 Click on cell C1 (should be blank if you deleted the correct number of fields), and type in 

“status” (must be in lower case letters) 

 Click on cell C2 and type in a “0” to set the status to available for selection 

 In cell C2, double click the bottom right hand corner of the cell to automatically fill the “0” 

value down the entire column 

 Autofit the entire table (select the 

entire table and double click on the 

line between columns A and B) 

 Click File, Save As, and select 

“Text (Tab delimited)” type and 

name the file  “pu.dat” 

 Ensure that your Save As window 

matches the figure to the right. 

 Click “Save” 

 Click “Yes” on the pop up dialog 

box 

 Close the “pu.dat” file in Excel 

 Click “No” on the pop up dialog box 

 Double check that the saved file ends with the extension .dat by visiting the location where it 

was saved “C:\IntroMarxan\ArcMap_data\pu.dat”. 

Now you have completed your pu.dat file. You 

have formatted it in this way and saved it as a .dat 

file because Marxan requires specific formatting 

and file types to work correctly.  The pu.dat file 

contains information for each planning unit on the 

cost of selecting it for inclusion in a Marxan 

solution, as well as the status for selection (locked 

in/out or available for selection).  

 

 Go to “C:\IntroMarxan\ArcMap_data\pu.dat” 

and open it with a text editor to review the 

information contained in the file and its 

format 
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Step 3: Creating the species file (spec.dat) 

In this step you will be creating the species file.  This is called the "species file" because when 

Marxan was first created, all of the conservation features were individual species. Now we call 

them "conservation features", but the file that lists them and their targets is still called the species 

file or spec.dat.  

 

This file lists the conservation features (each with a unique identifier or "id") and the target 

amount for that conservation feature (in this case, as a proportion of the total in the region or 

"prop") to be included in the reserve system. The "spf" column refers to the species penalty 

factor. You can also include the name of the conservation feature in the field "name" to help you 

keep track (many analyses will have hundreds of conservation features).  

For this exercise we provide you with:  

1. A layer that details the extent of benthic classes in the study region (Benthic_BC).  Each of 

the 55 benthic classes is a conservation feature.   

2. Layers detailing the distribution of sponge reefs and 3 different kinds of kelp: 

spngereefs_BC, giant_kelp_BC, bull_kelp_BC, and kelp_gen_BC. 

 

First, we will calculate the total area covered by each of the 55 benthic classes using the 

Benthic_BC layer, and the individual conservation feature distributions using their corresponding 

layers (for a complete list of features included and a description see page 12).  Then we will set a 

target of 30% protection of each conservation feature distribution using the “prop” field in the 

spec.dat file (i.e., 0.3 of the total area calculated for that conservation feature). We will leave the 

spf (species penalty factor) as the default value “1”. During Day 2 exercises you will have the 

opportunity to calibrate this value. Finally, you will repeat each step for each of the remaining 

conservation features: coral reefs and the 3 different kinds of kelp. 

 

Note: Each of the conservation features has been pre-assigned a unique identifier. There are 

many ways that this can be done using GIS software.  These data were prepared by giving each 

conservation feature a unique id when it was in feature class shapefile format, then it was 

converted to raster using this id.  If you are unsure about how this might be accomplished, 

please ask your instructor for an explanation at this time.  

 

Step 3a: Export conservation feature layers to Excel 

First, we will export the information from Benthic_BC 

(benthic classes) and open it in Excel: 

 In ArcMap, right click on the “Benthic_BC” layer and 

click on “Open Attribute Table”  

 Click on “Table Option” in the upper left corner of the 

table, then “Export” 

 In ArcMap 9.x click on “Options”, then “Export” 

 Type in 

“C:\IntroMarxan\ArcMap_data\Export_benthic.dbf” 
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 Be sure that your Export window matches to the right.  

 Click “OK” and do not add layer to the map, when prompted 

You will now create the conservation feature file, spec.dat.  

 Open “Export_benthic.dbf” in Excel.  The values in the first column “VALUE” are the 

species id, the values in the second column “COUNT” indicate how many pixels there are 

for each specie (or conservation feature) in the benthic data layer, and the values in the third 

column “NAME” show the names for each of the species.   

 Rename “VALUE” to “id” (must be in lower case letters), as this is what is required in 

Marxan  

 Delete column B 

In the “NAME” column, you will indicate the actual name of the species or conservation feature 

by following these steps: 

 Rename cell C1 from “NAME” to “name” (must be in lower case letters) 

 Use the find and replace function to replace all “–” with “_” (Marxan does not accept the  

“–” symbol); do the same with the “+” symbol, replacing with the word “plus” (you may 

need to untick “match entire cell contents” under “Options”) 

The species file is the file in which you must set a target amount for each conservation feature to 

be included in the solution.  We will set a target of 30% for each conservation feature by doing 

the following steps: 

 Click in cell C1 and name it “prop” (must be in lower case letters) 

 Type “0.3” in cell C2, (this will set the target at 30%)  

 In cell C2, double click the bottom right hand corner of the cell to automatically fill this 

function down the column 

Now you have unique ids, names, and targets for each conservation feature. The last step is 

adding the default value for the species penalty factor (spf).  

Step 3b: Create species penalty factor 

In the species file, you indicate the species penalty factor (spf) for each species (you will learn 

more about the use of and the meaning of spf later in this course).  For this 

analysis, we will use a value of “1” for all species/habitat types. 

 Click in cell D1 and name it “spf” (must be in lower case letters) 

 Click in cell D2, type “1” (this will be the spf value for each species), 

and double click the bottom right hand corner of the cell to 

automatically fill this function down the column (this is the default 

value for spf) 

Step 3c: Add individual conservation features layer and associated 
values to the spec table 

You will now  need to add information about the additional conservation 

features to the spec table (i.e., bull kelp, giant kelp, general kelp, and 
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sponge reefs).  Check the id for the additional conservation features.  Your benthic features have 

ids from 1-55. Look at the Table of Contents in ArcMap (or the screenshot on the right hand 

side) to determine the conservation feature ids for your other conservation features (e.g., for 

sponge reefs “spngereefs_bc” the id number is 56). 

 

At the bottom of your species file, add the appropriate conservation feature id, as well as the 

target and spf values that were entered for the benthic classes (prop “0.3”, and a spf of “1”).     

Step 3d: Save completed Marxan species file 

 Autofit the entire table (do this by selecting the entire table and double clicking on the line 

between columns A and B) 

 Click File, Save As, save in “C:\IntroMarxan\ArcMap_data\” and select “Text (Tab 

delimited)” type and rename the file to “spec.dat”  

 Click “OK” and click “Yes” on the pop up dialog box 

 Close the “spec.dat” file in Excel 

 Click “No” on the pop up dialog box 

 Double check that the saved file ends with the extension .dat by visiting the location where 

it was saved “C:\IntroMarxan\ArcMap_data\spec.dat”. 

 

Now you have created the spec.dat, the file that tells Marxan the unique identifier for each of 

your conservation features, the name of your conservation features, the target you want to meet 

for each conservation feature, and the species penalty factor (spf) value (that you will calibrate 

tomorrow).  

Step 4: Creating the planning unit versus species matrix (puvsp.dat) 

In this exercise, you will determine how much of each of the 

conservation features (benthic classes, sponge reef, and kelp) 

distribution is contained in each planning unit.  

 

Step 4a: Calculate area in each planning unit covered by each 
benthic class 

Note: Please ensure that the tables for your layers 

“pulayer_BC_Marine” and “Benthic_BC” do not have any rows 

selected or the tabulate areas function will not work correctly. 

 In ArcMap, right click on “pulayer_BC_Marine”, select “Joins 

and Relate” then “Remove Joins” then “Remove All Joins” 

 Under Spatial Analyst Tools, Zonal, click on “Tabulate Area” 

 Here you are calculating how much of each habitat type is in each planning unit.  The “Input 

raster or feature zone data” is your planning unit layer, and you want to make the area 

calculation for each planning unit, so you choose the PUID field as your “Zone field”.  The 

“Input raster or feature class data” for the third drop down box is the conservation feature 
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dataset you want to calculate the amount of for each planning unit.  Finally, you need to 

choose the “Class field” that identifies each conservation feature – the value field.  

 Ensure your Tabulate Area window has the following parameters: 

 

 
 

 Click the browse button  to specify the output table, type “Tabulate_benthic.dbf”, then 

click “OK” 

 Ensure the “Output table” says “C:\IntroMarxan\ArcMap_data\Tabulate_benthic.dbf” – it 

must be in the .dbf format, not the default format 

 Check to make sure that you are saving the .dbf file in the IntroMarxan folder 

Step 4b: Calculate area in each planning unit for remaining conservation features 

Repeat the tabulate area steps above for the remaining conservation feature datasets to calculate 

how much of each of the conservation features is contained in each planning unit.  Name the 

tabulate area files something that makes sense for each feature (for example, for the sponge 

reefs, tabulate_reef.dbf.).   

 

You can follow the directions above for the benthic classes to do this, just keep the feature zone 

data (pulayer_BC_Marine) and the Zone Field (PUID) the same, and vary the input raster and 

output table names.  Do not forget to save file as .dbf format.  

Step 4c: Join tables and export to Excel 

 Ensure that all of your .dbf tables are added to ArcMap 

 If you cannot see the tables in ArcMap, you will need to select the “List by Source” tab from 

the ArcMap 10 table of contents (or the “Source” tab in ArcMap 9.x) 

 Join all of the .dbf tables you just created to each other (be careful – don’t join them to the 

planning unit layer, you have already calculated the amount of each conservation feature in 

each planning unit, so you do not need to join the results back to the planning unit layer) 
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Note: the common information in all of the 

conservation feature tabulate area .dbf tables is 

the planning unit id or PUID – you will be 

joining them based on this field 

 To do this, right click on “Tabulat_benthic”, 

select “Joins and Relates”, “Join”, and join to 

the tabulate_reef.dbf.  

 Be sure that your Join Data window has the 

following parameters in the figure to the right 

(you may need to select “value” if “puid” is 

not an option). 

 Click “OK” 

 Now you will need to join the other tabulate 

area .dbf files for the other conservation 

features to the Tabulate_benthic.dbf  table. 

Join them in conservation feature number 

order (i.e., (1)Tabulate_bullkelp, (2) 

Tabulate_giantkelp, (3) Tabulate_genkelp).  

Use PUID field to join the different tables.  

 Make sure you join ALL of the other 

conservation features to the 

Tabulate_benthic.dbf 

 Export the joined data to a new table.  Right 

click on “Tabulate_benthic”, then “Data”, and save the table in 

"C\IntroMarxan\ArcMap_data\" as “tabulate_all_conservationfeatures.dbf”.   

Note: Do not add this table to the map, or we won’t be able to open it in Excel.  

 

NOTE: Data validation is of utmost importance when constructing Marxan datasets. Your 

reputation, your organisation’s reputation, and the reputation of the Marxan software is at stake 

if the data used in a planning process turn out to have errors in it. This is an unfortunate 

situation you can avoid with simple validation steps. This is one way to validate your 

calculations: 

 

 Validate the calculation by overlaying the Benthic_BC GIS layer with the planning unit layer 

to check if the results in the table correlate with the spatial data. Some GIS skills are 

necessary to perform this task. 

 Choose several planning units at random to perform these validation tasks 

 Zoom into the planning unit you have selected 

 Use the identify tool  to obtain the PUID of the planning unit  

 Record the PUID (ensure that you are looking at the puid and not the FID when you 

record this) 

 Overlay the Benthic_BC layer on the planning unit 
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 Use the identify tool  to obtain the VALUE identifier of one of the benthic types (one 

that only has a few grid cells will be easier to count) 

 Write the benthic type identifier down (e.g. 55) 

 Count how many grid cells of the benthic type appear in your planning unit 

 Record the number of grid cells of that benthic type  

 Ensure the spread sheet entry for the chosen planning unit (puid) and benthic type (eg. 

55) pair has the correct value (that is 100 * 100 * grid cell count = value of spread sheet) 

 You can repeat this procedure using the one of the other conservation feature layers (e.g. 

spngereefs_BC) 

 

Once you have validated that the datasets you have created are consistent with the original 

datasets, you need to continue processing the Excel spreadsheet that will become the puvsp.dat 

file. 

 Open tabulate_all_conservationfeatures.dbf in Excel and explore results.  Each conservation 

feature will be listed in the top row (e.g. VALUE_1) and each planning unit will be listed in 

the PUID field.  The area (meters squared) of each conservation feature was calculated for 

each planning unit. 

 If you scroll to column BE and BF you will find the columns “OID_1” and “PUID_1”. This 

is where the table Tabulat_reefs was joined to Tabulate_benthic.  There are columns called 

“OID_X” and “PUID_X” where each of the other conservation features were joined to 

Tabulate_benthic. Delete all of these columns after BE (including BE), EXCEPT ones that 

start with the word VALUE_.  For example, delete column BE (OID_1) and BF (PUID_1) 

but leave VALUE_56 because this column contains information about how much of the 

sponge reef conservation feature is contained in each planning unit.  At the end, column A 

will be called “PUID”, and all of the other columns will be “VALUE_XX” (where XX is 

conservation feature id 1-59). 

 Rename “PUID” to “pu” (must be lowercase), as this is required in Marxan 

 Now, select row 1 and find the “Find and Replace” tool (or hold ctrl and press the F key) 

 Be sure that your Find and Replace window has the following parameters: 

 

 

 Click “Replace All”.   

 

Now, we should get rid of the extra zeros after the decimal place as they are not needed: 
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 To get rid of the extra zeros after the decimal place, 

select the entire table 

 Click “Format”, “Cells” 

 Be sure that your Format Cells window has the 

following parameters in the figure to the right. 

 Click “OK” 

 Save the file in “C:\IntroMarxan\" as “Text (Tab 

delimited)” type and rename the file to “puvsp.dat”   

  Click “OK” 

 Click “Yes” on the pop up dialog box 

 Close the puvsp.dat file in Excel 

 Click “No” on the pop up dialog box 

 Double check that the saved file ends with the extension .dat by visiting the location where it 

was saved “C:\IntroMarxan\puvsp.dat”. Note that if you do not have admin access on the lab 

computer, you may need to actively save the file as “puvsp.txt” and manually change the 

ending to “.dat” 

Example of the "Puvsp.dat" file in “old” Marxan format: 

 
 

The puvsp.dat you have just created is in the old Marxan format (see above). To run with the 

optimized version of Marxan, and to use ZC, we need to convert the file format using the convert 

_mtx.exe tool.  You will find the tool, and directions for use in the C:\IntroMarxan folder.  

  

Note: Make sure that the conversion tool convert _mtx.exe and the file puvsp.dat are in the same 

folder C:\IntroMarxan 

 

 From the start menu, select “Start” > “Run”.  From 

the run window, type “cmd”, and click “OK” 

 Note: in Windows 7 the “Run” window is launched 

through “Accessories” 
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You should now see the command window, at the command prompt: 

 

 

 Type “cd c:\ IntroMarxan” (or the full pathname where data resides) and click return to 

change directories into the folder where the puvsp.dat file is located 

 Type “convert_mtx.exe 1 puvsp.dat puvsp2.dat” to execute the command  

 The conversion tool will then convert the file into the proper format (see below): 

 
 

 Open puvsp2.dat (in C:\IntroMarxan) with a text editor software (such as notepad). Note the 

change of formatting of the file (sample above to the right).  

 Copy the new puvsp2.dat in the folder C:\IntroMarxan\ArcMap_data 

Step 5: Creating the bound.dat file 

Create boundary file using Marxan tool. This file indicates the spatial 

relationship between the planning units and is essential for solutions 

that require spatial compactness. Id1 indicates the PUID for one 

planning unit, and id2 is the PUID for an adjacent planning unit. The 

boundary is the measurement of the boundary between the two 

planning units. 

Step 5a: Using ABP Marine Environmental Research (when 
using ArcGIS 10) 

 Ensure the ABP toolbar is showing, in ArcMap as per the 

installation instructions (circled in the screenshot below) 

 Select “pulayer_bc_marine.shp” fom the ArcMap TOC and click 

the ABP tool  
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 Select “PUID” as the PU field and click “Create file” 

 Save and rename the file created to “bound.dat” 

 

Step 5a: Using JNCC (when using ArcGIS 9x) 

To ensure the JNCC toolbar is showing, in ArcMap, click “View”, “Toolbars”, “JNCC ArcGIS 

Extensions”. 

 **Ensure** that pulayer_BC_Marine is the only layer 

on your layer list (remove all other layers) or the 

program may not execute (yes, it is picky).  To make 

sure all other layers and tables are removed, click the 

display and source tabs in the GIS layers window of 

your ArcMap project. If there are any layers or tables 

other than the pulayer_BC_Marine in under either of 

these tabs, remove them from the map.  

 Click the Create Marxan File button on the ArcMap 

tool bar   

 Type in “C:\IntroMarxan\ArcMap_data\bound.dat” in 

the “Enter the output filename” box. 

 Be sure that your Create Marxan File window has the 

following parameters: 

 Click “OK” 

Step 5b: Inspect the boundary 

We will now inspect the boundary file we have just generated. 

 Open Microsoft Excel 

 From Excel, use file > open to open “bound.dat”, import the file as a comma separated 

value file 

 You may see that the boundary file contains a lot of significant digits; for our analysis, 

we will round the length of each boundary to the nearest meter – to do this, format the 

cells in the boundary column by selecting “number,” then “0” decimal places in the drop 

down menu 
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 Save the changes to the file, but keep the file in the tab delimited format – make sure to 

close the file when you are done 

 Browse to the " C:\IntroMarxan\ArcMap_data" folder and right mouse click on the 

“bound.dat” file, selecting “Open” with Notepad 

 Scroll to the end of the file and delete the blank line as Marxan may not run with this 

extra blank line 

 Save the file and exit the program 

 

Note: The boundary maker tool has a sporadic glitch that sometimes results in malformed rows.  

For example, if you see a row in your file that ends in ",5000." do a search and replace with 

notepad to replace "5000." with "5000".  In some cases, Marxan will give an error message 

when running with a boundary file that contains these malformed rows.  The problem here is that 

there are no zeroes following the decimal place, which confuses the program when it tries to 

convert the text into a number. 

Step 6: Editing the input file (input.dat) file 

Congratulations! You are done creating the data files with ArcMap, and will now edit the input 

file for running Marxan, and organize the files you’ve just generated into the standard format. 

 

The input.dat file is like a list of instructions for Marxan where you will indicate the name and 

location of your other input files and set several parameters.  A detailed description of all the 

parameters that can be set in the input.dat is in the Marxan manual, which is in the documents 

section of your course folders. Note that we will not cover all of these parameters in this course.   

 

First, you will need to establish a specific structure for your files: 

 

 Browse to the IntroMarxan folder, create a new folder and name it “Marxan_Database” 

 In the Marxan_Database folder, create three new folders called “input”, “output”, and 

“pulayer” 

 Copy the “Marxan.exe” file into the “Marxan_Database” folder if your computer is 32-bit, 

or “Marxan_x64.exe” if your computer is a 64-bit.  

 Finally, copy the input.dat file provided into the “Marxan_Database” folder. 

 The files in the "Marxan_database" should appear as in the figure below: 
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 Copy the following files into the input folder: “bound.dat”, “pu.dat”, “puvsp2.dat” and 

“spec.dat” 

 Copy all 7 the files associated with the layer “pulayer_BC_Marine” into the pulayer folder 

(i.e.,“pulayer_BC_Marine.shp”, “pulayer_BC_Marine.shx”, “pulayer_BC_Marine.dbf”, 

“pulayer_BC_Marine.prj”, “pulayer_BC_Marine.sbn”, “pulayer_BC_Marine.sbx”, 

“pulayer_BC_Marine.shp.xml”) 

 Then, in the Marxan_Database folder, open “input.dat” in Notepad. This input.dat is the 

same as the sample input.dat you receive when you download Marxan or Zonae Cogito. 

Some of the parameters specified in this file will be set by you.  These parameters are 

indicated in the example input.dat (see next page). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Compare your input.dat to this one. Are the parameters the same?  
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 Find the first highlighted parameter, the BLM.  Set this parameter to 0 for the base 

Marxan database you are creating. BLM stands for Boundary Length Modifier, and the 

higher the BLM, the more “clumped” together your solutions will be.  

 Set the NUMREPS to 100. This is the number of solutions Marxan will find each time 

you run it.  NUMREPS stands for number of repetitions.  

 Leave the NUMITNS as 1000000. NUMITNS stands for number of simulated annealing 

iterations in each solution. 

 Make sure that the Input file and folder names match the names of your files.  

 SCENNAME You will change this to help identify which scenario the results are from. 

For now, just leave it as “output” as we are not yet setting up a scenario. 

 Make sure the OUTPUTDIR (output directory folder name) matches the name of your 

output folder. 

 Save the any changes made to your input.dat in the "Marxan_database" folder. 

 

To find out more about these and other parameters not described in this handbook, please consult 

the Marxan Users Manual. 

 

Well done! You’ve successfully created your first Marxan database with ArcMap.  

To continue go to Section C. Running Marxan for the first time.  
 

 

B. Creating Marxan input files with QMarxan in QGIS 

QGIS is an Open Source Geographic Information System (GIS) licensed under the GNU General 

Public License. It is an official project of the Open Source Geospatial Foundation (OSGeo). It 

runs on Linux, Unix, Mac OSX, Windows and Android and supports numerous vector, raster, 

and database formats and functionalities.  For more information visit http://www.qgis.org/ 

Qmarxan is a set of free software tools for the creation of Marxan input files within QGIS. It was 

written by Apropos Information Systems. This software suite allows you to build and run 

Marxan datasets on the computing platform of your choice (Windows, Mac OSX, or Linux). 

Here we describe the use of the software on Windows with a case study. For more information 

visit http://aproposinfosystems.com/products/qmarxan/ 

 Navigate to "C:\IntroMarxan\QMarxan_data" and double click on IntroMarxan.qgs to 

launch the QGIS project. 

 Explore each data layer so that you have a 

better understanding of the type of 

information that you will be working with in 

this course. 

Step 1: Creating Planning Units 

The size of the planning units is determined  by the 

scale of the analysis, the resolution of the data used, 
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and the objective of the planning exercise (see Marxan Good Practices Handbook for more 

information). Planning units can be squares, hexagons, or irregular shape polygons. With help of 

GIS you will calculate the area within each planning unit covered by each conservation feature 

distribution, and use these quantities to run a Marxan analysis. 

 

Next you will create a square grid for the British Columbia dataset with 2 x 2 km
2
 cells (2000 x 

2000 m
2
).  Note that the GIS data for the study region are in main units of meters. 

Step 1: Creating Planning Units using QMarxan 

This tool creates a planning unit grid with the following fields automatically created: pu_id, 

pu_cost, pu_status, bnd_cost, area, perimeter and side length.  

 In QGIS, click the "Plugins" menu, select "Qmarxan", then click "Create Planning Grid". 

 On the form that displays, select the "Planning 

Grid Extent" to be 

"Study_Region_BC_Ocean.shp", then click 

"Update extents from layer". 

 Check the option "Limit creation of grid by 

intersection with layer" to extract only those 

planning units that only fall within the study 

area. 

 Select "Side Length" to be "2000".  

Note: a larger side length will generate fewer 

planning units, and a smaller side length will 

generate more planning units. 

 Select Squares as planning grid shape,  

 Click the Browse button, browse to 

“C:\IntroMarxan\QMarxan_data”, and save the 

output shapefile as “pulayer_BC_marine.shp”, 

then click “Save” 

 Your form should then look like the figure to the 

right.  

 Now click "Ok" to generate the planning units. 

When it is finished running, click "Close". 

Step 2: Creating the planning unit file (pu.dat)  

Now you will be creating a Marxan planning unit file that contains the planning unit id, cost (of 

that planning unit), and status (availability for selection).  

Step 2a: Creating Cost Field 

 In the "Plugins" menu, select "Qmarxan", then click "Calculate Planning Grid 

Conservation Factor Values". 

 First click on the "New" botton to be able to fill out the form. 

http://pacmara.org/wp-content/uploads/2010/07/Marxan-Good-Practices-Handbook-v2-2010.pdf
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 On the form that displays, set "Planning Unit Layer" to "pulayer_BC_Marine", and 

"Planning Unit ID" as "pu_id". 

 Set "Select input layer type" to "Area", 

 Set "Select layer to measure" to "vessel_cost", 

 Select "Measure x Field", and select the field "GRIDCODE" for the calculation 

Note: this option multiplies the measured value (count, length, or area) by a field 

attribute in the layer you are measuring. This option would be best used for lengths or 

areas where there is a per unit value associated with the features you are measuring 

within the planning units (for more information visit 

http://aproposinfosystems.com/products/qmarxan/qmcalc/), 

 Select "Sum" in "On multiple intersection use" 

 Select "pu_cost" in the drop down menu bellow "Select Output Field Name".  

 Your form should then look like the figure below: 

 

 Now click "Run" to calculate the planning unit cost.  

 When it is finished running, click "Close". 

http://aproposinfosystems.com/products/qmarxan/qmcalc/
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The planning unit cost has been saved to the planning unit attribute table as a field called 

"pu_cost". 

Step 2b: Export data to create planning unit file 

 In the "Plugins" menu, select "Qmarxan", then click "Export to Marxan",  

 On the form that displays, set "Select Planning Grid" to "pulayer_BC_Marine", 

 Click the "Browse" button to set the 

output directory to " 

C:\IntroMarxan\QMarxan_data" 

 Click "pu.dat" tab to select the planning 

unit output file, 

 Check "Create Planning Units File 

(pu.dat)" to switch it on, 

 Set "Planning Unit Cost Field" to 

"pu_cost", 

 Set "Planning Unit Initial Status Field" 

to "pu_status", 

 Your form should then look like the 

figure to the right. 

 Click "Ok" to create the planning unit 

file "pu.dat" in the output folder "C:\ 

IntroMarxan\QMarxan_data".  

 Click "Close" to return to QGIS. 

Step 3: Calculate area in each planning 
unit covered by each conservation feature 

In this exercise, you will determine how much of each of the conservation features (benthic 

classes, sponge reef, and kelp) distribution is contained in each planning unit. This information 

will be used in Step 4 to produce the species file and the planning unit versus species matrix file.  

For this exercise we provide you with:  

1. One layer that detail the extent of 13 benthic classes in the study region.  Each of the 

benthic classes is a conservation feature.   

2. Layers detailing the distribution of sponge reefs and 3 different kinds of kelp: 

Sponge_reefs_BC, Kelp_Giant_BC, Kelp_Bull_Gen_BC, and Kelp_General_BC. 

Before you start with the processing steps, it is a good idea to open up the layers and their 

attribute tables to familiarize yourself with the data.  If you have questions about the data, ask 

your instructor.   

Note: Geometrically complex features may take longer to process.  To speed processing times, it 

is recommended to use the “Multipart to singlepart” tool in QGIS.  This tool can be found in 

VectorGeometry Tools   
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Once you have briefly explored the data, follow the next steps: 

 In the "Plugins" menu, select "Qmarxan", then click on "Calculate Planning Grid 

Conservation Factor Values". 

 First click on the "New" botton to be able to fill out the form. 

 On the form that displays, set "Planning Unit Layer" to "pulayer_BC_Marine", and 

"Planning Unit ID" as "pu_id". 

 Set "Select input layer type" to "Area", 

 Set "Select layer to measure" to "Sponge_Reefs_BC", 

 Select "Measure" in "On intersection use the following value" 

 Set "Enter New Measure Field Name" to “sponge_ref", 

Note: field names cannot be longer than 10 character name for a new field. This is the 

field width limit for shape files (see 

http://aproposinfosystems.com/products/qmarxan/qmcalc/). 

 Click "Save" 

 Your form should then look like the figure below: 
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 Now click "Run" to calculate the amount of sponge reefs found in each planning unit. 

 When it is finished running, click "Close". The planning unit attribute table now contains 

the amount of sponge reefs for each planning unit in the field "sponge_ref". 

 

 Repeat the above steps for each of the remaining conservation features (total of 5). Each 

time you repeat the step, substitute the layer name "Sponge_Reefs_BC" with the layer 

name you are currently processing, for example with the layer name “Kelp_Giant_BC”. 

You can run each conservation feature one at a time, or in group by clicking on "New" after you 

have "Save" your setting. For example, the form with 4 conservation features (sponges and 

kelps) should look like the figure below:  

Note: Doing this might slow down the processing time.  
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 For layers like the benthic habitat type form by more than one class within the same 

layer, it is possible to use the option "Multiple Fields" in "On Intersection assign value 

to", and then select the field with the unique identifier for each class. In addition, we also 

need to assign a prefix for the new field names that will be created and added to the 

planning unit layer. For example, we can add a prefix of "benth_" (it only accepts a 

maximum of 6 characters), which will result in a new field benth_1 for the habitat type 1.  

The form should look like the image below: 
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 Now when you open the attribute table of the layer “pulayer_BC_Marine” should contain 

a field for each of the 18 conservation features considered in each case study (open the 

attribute table to make sure you have 18 new fields). Each field contains the amount of 

each conservation feature in each planning unit.  Take some time to see if the field values 

make sense and that you haven't missed adding any conservation feature. 

 When you are finished, click "Close" to return to QGIS. 

 

NOTE: Data validation is of utmost importance when constructing Marxan datasets. Your 

reputation, your organisation’s reputation, and the reputation of the Marxan software is at stake 

if the data used in a planning process turn out to have errors in it. This is an unfortunate 

situation you can avoid with simple validation steps. 

 

 Validate the calculation by overlaying for example the Sponge_Reefs_BS, 

Benthic_Muddy_Flat layers, and the planning unit layer to check if the results in the table 

correlate with the spatial data. Some GIS skills are necessary to perform this task. 

 Choose several planning units where the two conservation feature layers overlap to perform 

these validation tasks. Start with selecting one planning unit: 

 Zoom into the planning unit you have selected 
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 Use the identify tool  to obtain the PUID of the planning unit  

 Explore the Identify Results (See figure below).  Note how much area is covered by the 

sponge reef and the benthic muddy flat habitat for that particular planning unit. 

 

 
 

 In this example, the benthic muddy flat habitat covers the entire planning unit, with a 

total area value of 4000000 m
2
 (which is also the total size of the planning unit). The 

sponge reefs almost completely cover the planning unit, with a total area of 3872554 m
2
.  

 When we visually inspect the spatial overlay of the conservation feature layers with the 

planning unit layer, we see that the estimated values by QMarxan correspond with what 

we observe.   

 You can repeat this procedure using the one of the other conservation feature layers or a 

different planning unit.  There are other ways to perform data validations, this is just one 

way.  
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Step 4: Creating the species file (spec.dat) and the planning unit versus species 
matrix (puvsp.dat) 

In this step you will be creating the species file. This is called the "species file" because when 

Marxan was first created, all of the conservation features were individual species. Now we call 

them "conservation features", but the file that lists them and their targets is still called the species 

file or “spec.dat”.  

The “spec.dat” file lists the conservation features (each with a unique identifier or "id") and the 

target amount for that conservation feature (in this case, as a proportion of the total in the region 

or "prop") to be included in the reserve system. The "spf" column refers to the species penalty 

factor.  In QMarxan, the “prop” and the “spf” values can be easily edited without the need to use 

a text editor.  The only field that cannot be modified is “name” of each feature, which is 

extracted from the field name created in the previous step.  This name can be edited outside 

QGIS with a text editor.  In any case, it is very important to keep track of the names or codes 

assigned to each of the conservation features to help you keep track (many analyses will have 

hundreds of conservation features). 

For the British Columbia dataset we will set a target of 30% protection of each conservation 

feature distribution using the “prop” field in the spec.dat file (i.e., 0.3 of the total area calculated 

for that conservation feature). We will leave the spf (species penalty factor) as the default value 

“1”.  You will have the opportunity to calibrate this value in the Day 2 exercises. 

Step 4a. Creating the spec.dat file 

 In the "Plugins" menu, select 

"Qmarxan", then click "Export to 

Marxan". 

 On the form that displays, set 

"Select Planning Grid" to 

"pulayer_BC_Marine", 

 Click the "Browse" button to set 

the output directory to 

"C:/IntroMarxan/QMarxan_data” 

 Click "spec.dat" tab to select the 

planning unit output file, 

 Click "Create Species File 

(spec.dat)" to switch it on, 

 In the "field_no" field, click the 

check boxes to switch on each of 

the conservation features (total 

20), 

 Edit the "prop" field for each of 

the conservation features to "0.3" 

(30% protection of each 

conservation feature). 

 Your form should then look like the figure to the right. 



 36 

 Now click "Ok" to create the species file. 

Step 4b. Creating the puvspr.dat file 

 Uncheck "Create Species File" since it has 

been already created. 

 Now Click "puvspr.dat" tab to select the 

planning unit output file, 

 Click "Create Planning Units vs Species 

File (puvspr.dat and puvspr_sporder.dat)" 

to switch it on, 

Note: the puvspr_sponder.dat is an inverse of the 

puvspr file (it is in species order) and its sole 

purpose is to speed up the burn in time when 

Marxan first runs. Its inclusion in my experience 

cuts the burn in time by about half. 

 Set "Scale species data from 0 to 1" to 

"Raw". 

 Your form should then look like the figure 

to the right. 

 Now click "Ok" to create the planning unit versus species matrix (puvspr.dat). 

 Click "Close" to return to QGIS. 

Step 5: Creating the boundary length file (bound.dat) 

This file indicates the spatial relationship between the planning units and is 

essential for solutions that require spatial compactness. Id1 indicates the 

PUID for one planning unit, and id2 is the PUID for an adjacent planning 

unit. The boundary is the measurement of the boundary between the two 

planning units. 

 In the "Plugins" menu, select "Qmarxan", then click "Export to 

Marxan". 

 On the form that displays, set "Select Planning Grid" to 

"pulayer_BC_Marine", 

 Click the "Browse" button to set the output directory to 

"C:/IntroMarxan/”, 

 Click "bound.dat" to select the boundary length output file, 

 Click "Boundary File (bound.dat)" to switch it on. 

 Your form should then look like the figure below: 
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 Now click "Ok" to create the boundary file (bound.dat). 

 Click "Close" to return to QGIS. 

Step 6: Establish a standard file structure for the Marxan database 

You are almost done creating the data files with QMarxan. The only file left to create is the 

input.dat file (see Step 7). But first you need to organize the already created files into the 

standard format. 

Using the Windows explorer: 

 Browse to the folder "C:\IntroMarxan\”, 

 Create a sub-folder here called "Marxan_database_backup", 

 Within the folder just created create a series folders called "input", "output", and 

"pulayer". 

 Copy the “Marxan.exe” file into the “Marxan_database_backup” folder if your computer 

is 32-bit, or “Marxan_x64.exe” if your computer is a 64-bit. 

 The files in the “Marxan_database_backup” should appear as in the figure below: 
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 Copy the following files into the “input” folder: “bound.dat”, “pu.dat”, “puvsp.dat”, 

"puvspr_sporder.dat",  and “spec.dat”. Your “input” folder should look like the figure 

below:  

 

 Copy all 5 the files associated with the shapefile “pulayer_BC_Marine” into the 

“pulayer” folder (i.e.,“pulayer_BC_Marine.shp”, “pulayer_BC_Marine.shx”, 

“pulayer_BC_Marine.dbf”, “pulayer_BC_Marine.prj”, “pulayer_BC_Marine.qpj”) 

Step 7: Creating the input parameter file (input.dat) 

The “input.dat” file is like a list of instructions for Marxan where you will indicate the name and 

location of your other input files and set several parameters.  A detailed description of all the 

parameters that can be set in the input.dat is in the Marxan User manual, which is in the 

documents section of your course folders. Note that we will not cover all of these parameters in 

this course.   

Note: Here we show you how to create this 

file with QMarxan. This file is also available 

when you download Marxan or Zonae Cogito.  

 In the "Plugins" menu, select 

"Qmarxan", then click "Configure 

Scenario". 

 On the form that displays, use the 

"Browse" button to set "Select 

scenario directory” to 

"C:\IntroMarxan\Marxan_database_ba

ckup”, 

 Now click on "Files and Costs" tab, 

and use the "Browse" buttons on that 

tab to specify the location of the 

different out files and Marxan files. 

 Your form should then look like this: 

 Now click "Ok" to create the input 

parameter file. 

 Click "Close" to return to QGIS. 
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These and other parameters specified in this file will be set by you.  You can edit the input file 

either in Notepad or using the "Configure Scenario" tool in QMarxan. These parameters are 

indicated in yellow in the example input.dat below. 

 

 Open the input.dat file saved in "C:\IntroMarxan\Marxan_database\” with Notepad.  

 

 
 

 Compare your input.dat to this one. Are the parameters the same?  

 Find the first highlighted parameter, the BLM.  Set this parameter to 0 for the base 

Marxan database you are creating. BLM stands for Boundary Length Modifier, and the 

higher the BLM, the more “clumped” together your solutions will be.  
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 Set the NUMREPS to 10. This is the number of solutions Marxan will find each time you 

run it.  NUMREPS stands for number of repetitions.  

Note: you can also change the BLM values and NUMREPS in QMarxan, in the 

"General" tab in the "Configure Scenario" tool. 

 Leave the NUMITNS to 1000000. NUMITNS stands for number of simulated annealing 

iterations in each solution.  

Note: you can also change the NUMITNS in QMarxan in the "Run and Annealing" tab in 

the "Configure Scenario" tool. 

 Make sure that the Input file and folder names match the names of your files.  

Tip: because you can use the same input file to run different scenarios, it is better to set 

the input directory INPUTDIR only as "input". Otherwise, you will have to make sure 

that the input directory always matches exactly with path where your Marxan input files 

are stored.  

 SCENNAME You will change this to help identify which scenario the results are from. 

For now, just leave it as “output” as we are not yet setting up a scenario. 

Note: you can also change the SCENNAME in QMarxan in the "Marxan Output" tab in 

the "Configure Scenario" tool. 

 Make sure the OUTPUTDIR (output directory folder name) matches the name and path 

of your output folder. 

Tip: because you can use the same input file to run different scenarios, it is better to set 

the output directory OUTPUTDIR only as "output". Otherwise, you will have to make 

sure that the output directory path name always matches exactly with path where your 

Marxan output file is.  

 Finally, under ‘Program Control’, in the last line of the file, add 

“SAVESOLUTIONSMATRIX   3”.  This file will be used during the second day to run 

the cluster analysis in R. (Currently QMarxan does not include this function 

automatically)  

 Save the any changes made to your input.dat in the Marxan_database folder. 

To find out more about these and other parameters not described in this handbook, please consult 

the Marxan Users Manual. 

 

Well done! You’ve successfully created your first Marxan database with QMarxan. Not it 

is time to run Marxan for the first time. 
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C. Running Marxan for the First Time 
After creating your Marxan database (either with the help of ArcMap or QMarxan), you are 

ready to run Marxan.   

 First make a copy of this folder and call it Marxan_database_backup. 

 Then, go to the Marxan_database folder, double click on “Marxan.exe” your computer is 32-

bit, or “Marxan_x64.exe” if your computer is a 64-bit 

If you have created all the input files properly, you should see Marxan generating solutions (see 

screen below).  If you see something else ask your instructor for assistance.  

 

 
 

D. Displaying Marxan spatial outputs  
Next we show you how to display the spatial outputs created by Marxan in ArcMap (section D.1) 

and in QGIS (section D.2) in order to create maps suitable for presentations, etc..  

D.1. In ArcMap 

Step 1: Convert best solution and sum solution files text files to Excel files. 

 Open "output_best.txt" from your local Marxan’s output folder 

(C:\IntroMarxan\Marxan_database\output\) with Excel 

 Select column A, and use Text to Columns wizard (in Data) to separate the fields into 

two columns.  Use Comma as your delimiter. 

 Save file as an Excel Workbook (.xls or .xlsx) with a file name "best_sol". 

 Repeat the above steps to convert "output_ssoln.txt" to excel. 

 Save file as an Excel Workbook (.xls or .xlsx) with a file name "sum_sol". 
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Step 2: Join output Marxan files to planning unit file 

 Open a new ArcMap project, or start ArcMap if you closed the program. 

 Add the planning unit file "pulayer_BC_Marine" saved in your Marxan_database 

(C:\IntroMarxan\Marxan_database\pulayer\).  

 Right click on “pulayer_BC_Marine” and select “Joins and Relates” and then “Join”.  In 

the first drop menu select the field “PUID”. In the second menu, browse for the 

"best_sol.xls" file. In the third menu, select “planning_unit” 

 Ensure your Join window has the following parameters shown in the figure below: 

 

 Click OK 

 Repeat the above steps to join the "sum_sol.xls" data to the planning unit file. 

Step 3: Visualize results in ArcMap 

 Go to the layer properties to visualize the best solution using the Categories visualization 

method, or the sum solution (or selection frequency) using the Quantities visualization 

method.   

 In the best solution, a value of "1" means that the planning unit was selected for the 

reserve, and a value of "2" that it was not selected.   

 Your results should look like the figures below: 

  
Best Solution Sum Solution 

 

This is the end of Day 1 Handbook. For extra exercises see Appendix. 
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D.2. In Quantum GIS 

These steps show you how to import your results from Marxan and display them in Quantum 

GIS: 

Step 1: Import Best Solution 

 Open a new QGIS project, or start QGIS if you closed the program. 

 Add the planning unit file "pulayer_BC_Marine" saved in your Marxan_database 

(C:\IntroMarxan\Marxan_database\pulayer\).  

 In the "Plugins" menu, select "Qmarxan", then click " Import Marxan Results". 

 Select your planning unit file "pulayer_BC_Marine" on the "Planning Grid" control, 

 Select "pu_id" on the "Planning Unit 

Id Field" control, 

 Browse "output_best" from your local 

Marxan’s output folder 

(C:\IntroMarxan\Marxan_database\out

put\)  to import the Best Solution, 

 Leave the default "--Create New--" on 

the "Select Results Field Name" 

control. This will add a new field to 

your planning unit layer that will 

contain the "Best Solution" calculated 

by Marxan.  

 Type "best_sol" on the "Enter New 

Results Field Name" control to give 

your new field a name. 

 Your form should then look like the 

figure to the right. 

 Now click "OK" to write the Marxan 

result file to the planning unit dbf table. 

Step 2: Import Summed Solution 

 If you closed the "Import Marxan 

Results" window, open it again. 

 Select your planning unit file 

"pulayer_BC_Marine" on the "Planning 

Grid" control, 

 Select "pu_id" on the "Planning Unit Id 

Field" control, 

 Browse "output_ssoln" from your local 

Marxan’s output folder 
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(C:\IntroMarxan\Marxan_database\output\)  to import the Best Solution, 

 Leave the default "--Create New--" on the "Select Results Field Name" control. This will 

add a new field to your planning unit layer that will contain the "Sum Solutions" 

calculated by Marxan, and also known as Selection Frequency.  

 Type "sum_sol" on the "Enter New Results Field Name" control to give your new field a 

name. 

 Your form should then look like the 

figure to the right: 

Note: You can repeat this process to add any 

solutions produced by Marxan.  In this case, 

any of the other 9 solutions produced by 

Marxan 

Step 3: Display Best Solution or Summed 
Solution 

 Double click on the planning unit layer 

in the list on the left panel of Quantum 

GIS, 

 Go to the Style Tab 

 To display the Best Solution, select 

"Categorized"  

 Select "best_sol" in the Column menu, 

and click on Classify. Value "1" 

represent selected planning units in the 

best solution, and value "0" selected 

planning units.   

 If you are happy with the colour, click 

OK.  You can change the colors of the 

symbol by double clicking on the 

colored symbol icon.   Here, selected 

planning units are displayed in green 

and not selected planning units in white. 

Your form should then look like the 

figure to the right. 

 Now click "OK" to display the Marxan 

result in Quantum GIS. 

 If you want to display the "Summed 

Solution", select the "Graduated" option 

in the style menu.  You can change the 

mode of classification and number of 

classes, as well as the range of values.  

Here the values are classified based on 

Natural Breaks, using 7 classes, and 
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setting the first class to only display 0 values. Your form would look like the figure to the 

right: 

 Now click "OK" to display the Marxan result in Quantum GIS. 

 Your results should be similar to the figures below:  

 

  
Best Solution Sum Solution 

 

 

 

This is the end of Day 1 Handbook. For extra exercises see Appendix. 
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Appendix: Extra Exercises  

In the first extra exercise, you will learn an alternative method to create a planning unit layer 

using a free extension for ArcMap, called Jenness Repeating Shape (for more information about 

Jenness Enterprises, go to www.jennessent.com/arcgis/arcgis_extensions.htm).  

 

In the second extra exercise, you will use a tool called Zonae Cogito to create some of your input 

of files.  We will discuss this tool more in Day 2 of the course. 

 

Creating Planning Units using Jenness Repeating Shapes 
 
Note: This tool uses the cell centroids instead of the cell corners to match the extent of the grid to 

the extent of the study area.  To match the grid perfectly with the extent of the study area, first you 

will have to snap the grid to the lower corner of the study area layer (i.e. 

Study_Region_BC_Ocean), and second delete the excess row and column on the upper right 

corner. 

 

 In ArcMap, click on the repeating shapes tool 

 In the box labelled “Select the region to cover:” 

select “Within the Extent of a Particular Layer” 

and click “Next…” 

 Select ‘Study_Region_BC_Ocean’ and click 

“Next…” 

 Select the “Squares” option and click “Next…” 

 Enter the following parameters as shown here:  

 Type “2000” in the “Edge” box  

 Specify C:\IntroMarxan\pulayer.shp as the 

“Output Feature Class or Shapefile:”  

 Click “OK” 

 Click “Exit” after viewing the report  

 
An alternative way to create some of the input files 

 

You can use a tool in Zonae Cogito to help create some of the input files. We had you create 

these files by hand so you could be familiar with how they are put together and what they 

contain. Automated files include pu.dat, spec.dat, puvspr.dat, and sporder.dat (a file used to 

speed up processing). The pu.dat and spec.dat need to be updated after they are created 

automatically.  This tool can be a real time saver for the creation of the puvspr.dat file.  Before 

using this tool, you would need to (1) have created your planning units and given them a unique 

id, and (2) performed a Tabulate Area to create a .dbf for each of your conservation features (as 

you did above when creating your puvspr.dat file). At least one of your conservation feature 

groups needs to have full coverage of the study region. As a result, we have added a new 

http://www.jennessent.com/arcgis/arcgis_extensions.htm
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“conservation feature” that covers the entire region.  To practice using the DBF tool, you can use 

the Tab Area .dbf files that you created earlier and the new entire region .dbf that we provide. 

 

The first step is to place all of your tab area results (the .dbf files you used to calculate how much 

of each conservation feature was contained in each planning unit) into one folder. To do this: 

 

 Create a folder in C:\IntroMarxan called “TabArea” 

 Copy all of the Tabulate area .dbf files you created (e.g. Tabulate_benthic.dbf) to the 

TabArea folder 

 Copy the file Tabulate_area_region.dbf from the C:\IntroMarxan folder into the TabArea 

folder 

 

Zonae Cogito was created as a user interface/ decision support tool for use with Marxan. The 

DBF table join tool joins your tabulated conservation feature data (in DBF form) together into 

the correct format for Marxan.  In addition, it can create a “base” spec.dat, pu.dat, and 

sporder.dat file.  

 

 Open Zonae Cogito (ZC) from the program menu 

 If Zonae Cogito does not appear in the program menu, browse to “C:\Program Files\Zonae 

Cogito”, and double click ZonaeCogito.exe to launch the program 

 In the ZC Main Menu, choose Convert Data>Tables>Join DBF tables puvspr 

 

The window shown below will appear:  

 

 

 

 

 

 

 

 

 

 

 

 

 

 Browse to the C:\IntroMarxan\TabArea folder where your .dbf files are saved 

 Ensure that the rest of the settings are as below – the Feature Index Type will assign a 

unique identifier to each of your conservation features, and by ticking the “create pu.dat”, 

“create spec.dat”  and “create sporder.dat” boxes, ZC will create a base file for pu.dat and 

spec.dat for you to edit and a sporder.dat for you to include in your database (this will not 

need to be edited) 

 Click “Execute Join” 
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The process might take a minute or two to complete.  

 

 When it is finished running (you will see a screen pop up, run something, and close), open 

the TabArea folder 

 Open the folder called “Marxan” – ZC has created an entire Marxan database 

 Copy the entire Marxan folder and place it in C:\IntroMarxan, naming it 

“Marxan_database_auto” 

 Open the puvspr.dat file (in the input folder) with a text editor – note that the file is now in 

the necessary format (species, pu, amount sorted by planning unit) 

 Open the pu.dat file with a text editor – the ZC tool has produced a “base” pu.dat file, and to 

use this you would simply need to update the cost and status data (using spreadsheet 

software like Excel) like you did in the exercises above 

 Open the spec.dat file – this is also a “base” file, and you can add in a name field (using a 

spreadsheet software like Excel) to more easily identify which id number refers to which 

conservation feature 

 

The ZC tool assigned a unique index to each conservation feature.  

 

 Open the file called “feature_index_assignment.csv” (respond “Yes”, then “OK” to the pop-

ups)  

 Review the file, noting how the conservation feature ids have been assigned 

 

You can use this tool to create all of the basic input files EXCEPT the bound.dat. 

 

If you still have extra time (on Day 1), try creating another Marxan database using terrestrial data 

from Tasmania (located at C:IntroMarxan\Extra_Activities\Tasmania). 5000m x 5000m planning 

units are sensible for this problem, but feel free to experiment with different planning units. If 

you require step by step instruction for this extra activity, you can use the document Case Study 

Profile Tasmania.doc in the C:\IntroMarxan\Extra_Activities\Tasmania folder. 

 

 

 


